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Warranty 
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1 Introduction 

1.1 Overview 

As part of the Akrometrix Studio software platform, Surface Measurement is 
designed as the data acquisition package for any Akrometrix hardware utilizing the 
shadow moiré, fringe projection, or DIC techniques. It features a multiple document 
interface where the user interacts with child windows and context menus allowing many 
types of information to be displayed and compared on screen at one time. 

This manual describes the interface and functions of the Surface Measurement 
software. Automated data acquisition during a thermal profile is described in the 
Thermal Profiler User Manual and analysis is described in the Surface Analysis User 
Manual. Surface Measurement requires system hardware to operate and, thus, will only 
be installed on computers attached to Akrometrix measurement equipment. Surface 
Analysis may reside on the measurement equipment computer and/or on a remote 
computer. 

A user unfamiliar with shadow moiré, fringe projection, and DIC and their application 
in Akrometrix measurement systems is advised to first read Akrometrix Techniques 
and Analysis 101. 

Section 2 describes the program interface and its functions. Section 3 describes 
the program functionality while in DFP mode. Section 4 describes the program 
functionality while in DIC mode. Section 5 describes common problems and 
troubleshooting. Appendix A describes software file formats and keyboard shortcuts. 

1.1 Warnings and Notes 

1.1.1 Warnings and Notes in this Manual 

Warnings and Notes are marked throughout the manual with these icons: 

 

Figure 1.1 Warning Icon 
 

Figure 1.2 Note Icon 

Warnings are specific health hazards for the operator or potential sources of system 
damage. Notes highlight system limitations or automatic responses that may require 
corrective action by the operator for successful operation. 

1.2 Technical Support 

For technical support, contact Akrometrix: 
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Akrometrix 

2700 NE Expressway 

Building B, Suite 500 

Atlanta, GA 30345 

404-486-0880 

404-486-0890 (fax) 

support@akrometrix.com 

http://www.akrometrix.com 

When contacting Akrometrix, please provide the system serial number, the version 
numbers of the Akrometrix software being used, a description of the problem or 
question, and contact information for reply. If the question concerns a particular 
measurement or analysis, please provide electronic copies of the phase images, 
reference images, and final results and a description of data acquisition and/or analysis 
conditions. If the problem concerns changes or failure in general system operation, 
please describe any events or system modifications that occurred immediately before 
the problem arose. 

mailto:support@akrometrix.com
http://www.akrometrix.com/
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2 Surface Measurement 

2.1 Start-up 

1. Run Surface Measurement by clicking the Surface Measurement button in the 
Studio Manager bar on the left side of the screen. Alternatively, the program can 
be run from the desktop shortcut or by pointing to StartAll 
ProgramsAkrometrixSurface Measurement. A start-up splash screen 
appears while the software initializes.  

2. When asked whether or not to home the grating stage, ensure that all 
obstructions are removed from the stage path and press Yes. If No is pressed, 
the application will continue to load without homing the sample support motors. 

 

Note: Pressing No will decrease program startup time. 
In this case, however, absolute sample support position 
will not be available.  

3. The main Surface Measurement screen will display. The parent window contains 
a camera view and all other windows that the program spawns. 

2.2 Acquiring Data 

1. Position the sample under the grating, using the Camera window (see Figure 
2.1) to line up edges of the part so that they are more or less parallel with the 
edges of the camera view. 

2. Adjust the region of interest, or ROI, such that it fully encompasses the part to be 
measured. 

3. Adjust the sample/grating height using the Sample Height Adjust Window (see 
Figure 2.2) so that there is adequate fringe contrast on the sample. It may also 
be necessary to adjust the camera iris settings to get adequate brightness on the 
sample. Use the highlight saturated and dark pixels options to avoid getting 
saturation in the fringe image. These can be activated by going to the Camera 
Control window described in Section 2.3.2. 



Surface Measurement User Manual 

 

 30-50SW-0002 Rev. D Page 7 of 38 

 

Figure 2.1 Camera Window, Information Bar Circled 

 

Figure 2.2 
Sample Height 
Adjust Window 

4. Right-click on the Camera window to bring up a context menu (see Figure 2.9) 
that contains the Acquire… command. Click Acquire… or, alternatively, press the 
F12 key. 

2.3 Information Bar 

At the bottom of the Camera window (see Figure 2.1), an information bar displays 
relevant acquisition parameters for quick user reference. These include 

 which grating is selected (if more than one is installed on the system) 

 the camera iris setting 

 the phase amplitude 

 the ROI location and size, in pixels 

 the XY Orientation; Pin 1 Location and Measured Side 

 the Part Tracking ON/OFF setting 

Each one of these parameters can be edited by clicking on the desired parameter. 
See the following sections for a brief description of each parameter and how it can be 
edited. 

2.3.1 Grating 

The grating parameter area has an arrow on the right side. When clicked, it opens a 
window containing the calibration routines for a grating as well as a grating editor 
screen. See Section 2.8 for instructions on using the calibration routines. 



Surface Measurement User Manual 

 

Page 8 of 38 30-50SW-0002 Rev. D 

When more than one grating is installed on the system, clicking directly on the 
grating information area brings up a grating selection menu. The user can select among 
the available gratings to be the active grating. 

 

Figure 2.3 Grating Pop-Up Menu 

 

Figure 2.4 Edit Grating Window 

 

Figure 2.5 Select Grating Menu 

2.3.2 Camera Iris 

To the right of the Grating Parameters section is the Camera Iris setting. This area 
shows the current camera iris setting in percentage form. A Camera Control dialog can 
be opened by clicking on the Window menu at the top of the main screen. This dialog 
can control the camera iris setting as well as turn on and off highlighting of dark or 
saturated pixels. 
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Figure 2.6 Camera Control Window 

2.3.3 Phase Amplitude 

This section displays whether or not Phase Amplitude Thresholding is turned on, 
and, if so, what its value is set to. Again, this parameter can be edited by clicking on the 
phase amplitude area to open a setting dialog. 

 

Figure 2.7 Phase Amplitude Adjustment Window 

2.3.4 ROI Location 

This section describes where in the field of view the ROI, or region of interest, is 
located and what its size is in pixels. Clicking on this area brings up a dialog that allows 
precise adjustment of the position and size of the ROI. 

 

Figure 2.8 ROI Adjustment Window 
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The ROI can also be adjusted using the following keyboard shortcuts when it has 
focus. Shifting can be done using the arrow keys or the outer number keys located on 
the NumPad. Each press of a key results in one pixel shift of the ROI.  

For example: 

Up Arrow or 8 on NumPad Move ROI up one pixel 

7 on NumPad   Move ROI up one pixel and left one pixel 

Holding down Ctrl while pressing any of these keys will now increase the ROI size 
in the desired direction. Ctrl+5 will make the ROI its maximum size. Holding down Alt 
while pressing any of these keys will decrease the ROI size in the desired direction. 
Alt+5 will make the ROI half of the maximum length and width and position it in the 
center of the field of view. 

2.3.5 XY Orientation 

For purposes of orienting and registering surface data in Interface Analysis, a new 
section has been added to the Camera Window Information Bar. Clicking on this area 
brings up a dialog where the user can input Pin 1 Location and Measured Side of the 
phase image that is captured on Acquire. 

2.3.6 Part Tracking: ON/OFF 

This section of the Information Bar simply shows whether Part Tracking is currently 
On or Off. 

2.4 Camera Window Context Menu 

There are several different commands that can be issued when interacting with the 
Camera window in Surface Measurement. These commands can be accessed by right-
clicking within the Camera window and include: 

 Acquire… F12 

 Enable Part Tracking 

 Shrink To Fit 

 Square Bounds 

 Fill ROI F3 

 Save Full Field Image… 

 Open Thermal Profiler… Ctrl+T 

 

Figure 2.9 Camera Window Context 
Menu 

The Square Bounds command will only be available if the user right-clicks inside of 
the ROI. 

2.4.1 Acquire 

The Acquire command performs a onetime phase image capture. 
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2.4.2 Enable Part Tracking 

Enables the Part Tracking functionality in Section 2.10. 

2.4.3 Shrink To Fit 

If checked, the camera image is forced to the window size. 

2.4.4 Square Bounds 

Forces the ROI to be square using the smaller of its two dimensions. 

2.4.5 Fill ROI 

Toggles whether or not the region of interest appears as a transparent square or as 
a square outline. 

2.4.6 Save Full Field Image 

This command will save an image in *.png format of exactly what the user sees 
within the Camera window, ROI included. 

2.4.7 Open Thermal Profiler 

This command opens a separate application in the Studio Suite called Thermal 
Profiler. This allows automated data capture while subjecting the sample to a thermal 
profile. For more details please see the Thermal Profiler User Manual. 

2.5 Phase Image Context Menu 

There are several different commands that can be issued when interacting with a 
Phase Image in Surface Measurement. These commands can be accessed by right-
clicking within the Phase Image window and include: 

 Save…    Ctrl+S 

 Save Image…   Ctrl+I 

 Open in Surface Analysis… Ctrl+O 

 Properties… 

2.5.1 Save 

Saves the phase image as a *.akx_phase file which can be analyzed using Surface 
Analysis. The phase image name is constructed from the date and time at acquisition, 
but can be changed by the user. 

2.5.2 Save Image 

Saves the phase image as either a *.bmp or *.jpg image file. 
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2.5.3 Open in Surface Analysis 

Opens the phase image in Surface Analysis. The file is not saved to disk at this 
point so the user will still need to save the image if long term storage is required. 

2.5.4 Properties 

Views phase image properties in a separate window. 

2.6 3D Surface Image Context Menu 

There are several different commands that can be issued when interacting with a 
3D Surface Image in Surface Measurement. These commands can be accessed by 
right-clicking within the 3D Surface window and include: 

 Save… 

 Save Image… 

 Export Legend… 

 Print… 

 Open in Surface Analysis… 
 

Figure 2.10 3D Surface Image Context Menu 

2.6.1 Save 

Saves the 3D surface image in one of the following data formats: *.akx_disp, *.dat, 
or *.txt. Only the *.akx_disp file can be loaded back into Surface Analysis. 

2.6.2 Save Image 

Saves the 3D surface image as either a *.png or *.jpg image file. 

2.6.3 Export Legend 

Allows the user to create and export a legend image as either *.png or *.jpg image 
file. 

2.6.4 Print 

Prints the 3D surface image. 

2.6.5 Open in Surface Analysis 

Opens the 3D surface image in Surface Analysis. The file is not saved to disk at this 
point so the user will still need to save the image if long term storage is required. 

2.7 File Menu Bar 

At the top of the Surface Measurement application window there is a standard 
Windows File Menu bar (see Figure 2.11). It contains the following menu categories: 

 File  Tools  Window  Help 
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2.7.1 File 

The File menu will change depending on what type of window has focus. It will have 
relevant commands for the currently selected window type. For example, if the Camera 
window is selected, it contains an Acquire command, a Save Full Field Image command 
and an Exit command. 

 

Figure 2.11 File Menu 

2.7.2 Tools 

The tools drop down menu contains four items. The first, a grating manager, allows 
the user to add or remove gratings from the system. The second opens the Thermal 
Profiler app. The third allows the user to check the measurement accuracy of a normal 
step height block (see Section 2.8.3). The last selection opens system options as 
described in Section 2.9. 

 

Figure 2.12 Tools Menu 

2.7.3 Window 

This menu item contains commands for managing the child windows that are 
present within the parent Surface Measurement window at any time. Windows that may 
be hidden behind other windows can be brought to the foreground by selecting them in 
this drop down menu. All open windows can also be closed by selecting the Close All 
Windows command. The Camera (Section 2.2), Sample Height (Section 2.2), and 
Camera Control (Section 2.3.2) windows are always available in this menu. 
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Figure 2.13 Window Menu 

2.7.4 Help 

This menu item contains a link to the Surface Measurement User Manual as well 
as an About command for determining program version information. 

2.8 Grating Calibration Routines 

The grating calibration routines can be accessed by clicking the small arrow to the 
right of the Grating information area on the Information bar (see Figure 2.14). Clicking 
on either one of these items will put the system in the respective calibration mode. The 
user must deselect the calibration mode when calibration is complete. 

 

Figure 2.14 Grating Pop-Up Menu 

2.8.1 DAQ Fringe Height 

In the Calibrate DAQ Fringe Height mode, a uniform white colored continuous 
surface sample is used to determine the optimal phase step distance based on the 
optical configuration of the system. The calibration sample is provided by the user and 
can be any white colored, continuous surface sample that is at least 100mm x 100mm. 
The sample must also be sufficiently stiff so as to maintain its shape while phase 
stepping occurs. 

1. When Calibrate DAQ Fringe Height mode is enabled the ROI bounding box 
becomes a dashed outline.  

2. After placing a uniform white colored continuous sample in the measurement 
system, adjust the ROI such that it only encompasses a continuous part of the 
sample. 
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3. Right click to select Start Calibration… from the Camera window context menu. 
A series of images is taken with different step heights to determine the best 
calibrated phase step distance, or DAQ Fringe Height. While the images are 
being taken a dialog (see Figure 2.15) pops up showing the captured images 
and a plot of the intensity standard deviation for each step height trial. 

 

Figure 2.15 DAQ Fringe Height Cal Dialog 

4. At the completion of the calibration routine a dialog pops up asking the user to 
update the DAQ Fringe Height.  

5. Press Yes to approve and save the new DAQ Fringe Height. If an error is 
suspected (refer to Section 5.1), press No to discard the new calibration value. 

2.8.2 Fringe Value 

In the Calibrate Fringe Value mode, a single step calibration block is used to 
determine the Fringe Value calibration constant for the system. This block is provided 
with the measurement system. See Akrometrix Techniques and Analyses 101 for 
more details on this calibration constant. 

1. Enter the calibration offset value in the Calibrate Fringe Value dialog box that 
pops up and click OK. The calibration offset value for the block is on the 
Calibration Certificate provided with each block. Please note that the relevant 
number will either be listed as “Distance” or “DIST_A_to_B” depending on what 
independent lab was used to calibrate the block. Please see Figure 2.16, Figure 
2.17, and Figure 2.18. 
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Figure 2.16 Offset Value Dialog 
 

Figure 2.17 Offset Value from Certificate (ATS) 

 

Figure 2.18 Offset Value from Certificate (Quindos) 

 

2. Adjust the ROI such that the outside square approximately outlines the 
calibration block. Exact alignment is not required because measurements are 
made only within the inner two rectangles, which are inset from the outside 
boundary. 

3. Right click within the ROI and click Start Calibration… The calibration process is 
initiated and three windows pop up afterward. These windows show the phase 
image, the displacement data, and a Confirm Calibration Results dialog. 

4. Press Yes to approve and save the new Fringe Value. If an error is suspected 
(refer to Section 5.1), press No to discard the new calibration value. 
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2.8.3 Accuracy Check 

Under the Tools menu at the top of the program there is an Accuracy Check 
function, which is used for checking the normal height between two surfaces. This is 
useful for checking system accuracy against a cal block with a machined step height in 
it. Typically, the accuracy check measurement is compared with that of a CMM or laser 
based profilometer measurement.  

2.9 Software Options 

Surface Measurement options can be accessed by going to Tools → Options. A 
Dialog appears as in Figure 2.19. 

 

Figure 2.19 Options Dialog 

2.9.1 Delay per Step 

Determines the amount of time in milliseconds the software waits between each 
phase step. Increasing this value can be useful for samples that exhibit excessive 
vibration between each phase step. Keep in mind, however, that increasing this value 
will increase total data acquisition time. 

2.9.2 Smooth Displacement 

Runs a smoothing algorithm on the displacement data. See Akrometrix Optical 
Techniques and Analyses 101 for more details. 

2.9.3 Surface Units 

Determines what units the Surface Windows display in. Options are mils or microns. 

2.9.4 Position Units 

Determines what units the Sample Height dialog displays the current motor travel 
position in. Options are mils or microns. 
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2.9.5 Close All Windows on Acquire 

On Acquire, closes all open phase images and surface windows within the Surface 
Measurement parent window. Setting this to false will spawn a new phase image 
window and/or displacement window on each Acquire. 

2.9.6 Full Field Composite Window 

On Acquire, displays a window showing the entire camera FOV with the phase data 
overlaid on top. 

2.9.7 Phase Window 

On Acquire, displays a window showing the phase image captured. 

2.9.8 Surface Window 

On Acquire, displays a window showing the 3D surface calculated from the 
captured phase image. 

2.10 Part Tracking 

Part Tracking is the revolutionary new feature in Akrometrix Studio which has the 
potential to reduce analysis time of multiple part runs by more than 90%. It is designed 
to find and track rectangular parts of a user defined size at room temperature and 
during a temperature profile. Traditionally, if a part happened to shift or rotate during a 
thermal run, the user would need to spend many painstaking minutes manually 
partitioning and rotating the data such that the resulting displacement plots did not have 
any artifacts. With Part Tracking, all the resulting data at the end of a thermal run should 
automatically be partitioned and rotated to the same starting orientation, greatly 
speeding analysis time. Part Tracking even improves work flow and productivity when 
only one sample is tested and moves due to thermal expansion. The more samples 
tested at once, the more productivity will be improved. 

2.10.1 Part Tracking Window 

 Rectangle – Defines the Rectangle Model size that Part Tracking will try to 
find parts with. This can be buttoned in manually or set from the ROI/Search 
Area context menu. The rectangle model size is represented by the white 
box on the right side of the Part Tracking window. 

 Search Settings  

o Number of Instances – Defines the number of parts which Part 
Tracking should expect to find. In order to eliminate finding “ghost” 
parts, Akrometrix recommends setting this to the exact number of 
parts in the oven. The max number of instances is 99. 

o Rotation – Defines the rotation tolerance for finding a part. This will 
allow parts to be found which aren’t perfectly aligned with the camera 
pixels. Akrometrix recommends setting parts up such that they are 
within 10° of normal to the camera and using as little rotation tolerance 
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as possible. Increasing this value can increase the risk of finding 
“ghost” parts. The max rotation tolerance is 30°. 

 

Figure 2.20 Part Tracking control window in Surface Measurement 

o Scale – Defines the scale tolerance for finding a part. This will allow 
parts to be found which aren’t exactly the same size as the rectangle 
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model. This can be useful when comparing results between systems 
that have ever so slightly different zoom factors. In Figure 2.20 above, 
the scale tolerance of 2% on a rectangle model of 168 x 168 pixels will 
allow Part Tracking to find parts which are anywhere from 165 x 165 
to 171 x 171. Increasing this value can increase the risk of finding 
“ghost” parts. 

o Minimum Match – This defines the percentage of edge which Part 
Tracking has to find to determine that a feature in the camera image is 
a part. Decreasing this setting will increase the risk of finding “ghost” 
parts. 

 Inset (pixels) – Determines the number of pixels to crop in on found parts. 
This will effectively reduce the ROI on a part and can be useful for reducing 
or eliminating edge displacement artifacts. 

 Target Image 

o Increase Contrast – Increases the contrast of a surface image before 
tracking parts on it. This can be useful for finding parts which have low 
contrast with their background in the oven. 

All of the settings above can be saved in a part tracking file known as *.akx_track. 
This allows settings to be reused from run to run and site to site without having to button 
in every last setting. 

 

Figure 2.21 Part Tracking File Menu 

 

Figure 2.22 Part Tracking Options Window 

 

Figure 2.23 Part Tracking View Menu 

 

 File Menu – Load and Save *.akx_track files as well as Open previously 
saved Target Images which can be either *.bmp or *.akx_phase 

 Options – Allows the user to retain acquired target images in memory so 
that the part finding options can be experimented with to find the appropriate 
number and location of parts. 
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 View – Allows the user to show or hide the Rectangle Model and Target 
Images display. See the result with both being shown in Figure 2.24. 

 

Figure 2.24 Part Tracking window with Target Images 

 

Figure 2.25 Target Image Tab Menu 

 

Figure 2.26 Target Image Context Menu 

In the Target Images display section of the Part Tracking window, there are two 
more right-click context menus available to the user. The user can close tabs using the 
context menu shown in Figure 2.25, as well as search and save Target Images using 
the menu shown in Figure 2.26. 

2.10.2 Multi-ROI Results Window 

In order to display Part Tracking results, a separate Multi-ROI results window was 
developed. This window allows the user to see the following items in one result window. 

 Surface Image 

 Phase Image 



Surface Measurement User Manual 

 

Page 22 of 38 30-50SW-0002 Rev. D 

 Displacement Plot 

 Camera/ROI Selection  

 

Figure 2.27 Multi-ROI Surface View 

 Surface Image View – Shows the Surface Image (average of 4 intensity 
images) or any of the 4 intensity images for the selected ROI. A save Image 
option is available in the context menu. 

 

Figure 2.28 Multi-ROI Phase View 
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 Phase Image View – Shows the Phase Image for the selected ROI. The 
same context menu options that are available in a single phase image are 
available in this Multi-ROI Results window. 

 

Figure 2.29 Multi-ROI Displacement View 

 Displacement Plot View – Shows the resulting 3D displacement from the 
measurement. The same context menu options that are available in a single 
displacement plot are available in the Multi-ROI Results window. 

 

Figure 2.30 Camera/ROI Selection Context Menu 

 Camera/ROI Selection Window – Click on a found part ROI to display the 
data from that ROI in the left window pane. Right-click to bring up the context 
menu which allows zooming to the found ROI extents, or toggling the Overlay 
Phase function. 
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3 DFP Surface Measurement 

The interface and operation of the DFP Surface Measurement program are very 
similar to the Surface Measurement program. A user unfamiliar with the Surface 
Measurement software should read Section 2 first or refer to it where necessary for 
operation of the DFP software. In this section, only DFP specific functions will be 
described. 

In the DFP module, a digital projector is software controlled for displaying and 
phase shifting fringes on the sample surface.  

 

Note: The sample height adjustment stage is still in 
use. Instead of executing phase shifting, it is used to 
move the sample vertically for focusing purposes. 

3.1 Start-up 

1. Remove the TherMoiré grating from the oven lid if it is in place. 

2. Install the DFP module. (Refer to the DFP User Manual). 

3. Run the DFP Surface Measurement program by clicking the corresponding 
button on the Akrometrix Studio Manager toolbar on the left side of the screen. A 
start-up splash screen appears while the software initializes.  

4. When asked whether or not to home the grating stage, ensure that all 
obstructions are removed from the stage path and press Yes. If No is pressed, 
the application will continue to load without homing the sample support motors. 

 

Note: Pressing No will decrease program startup time. 
In this case, however, absolute sample support position 
will not be available.  

5. The main screen will display and it looks very similar to the normal Surface 
Measurement interface.  

3.2 Calibration 

Akrometrix believes that calibration should be performed whenever: 

 The DFP system is initially installed 

 Individual optical components, such as the projector, or video camera have 
moved 

The following procedure assumes that the system has already been aligned 
according to the DFP User Manual and requires the use of a white painted optical flat 
(Figure 3.1) provided with the system. 



Surface Measurement User Manual 

 

 30-50SW-0002 Rev. D Page 25 of 38 

1. Place the flat in the system on the normal sample support rails at roughly the 
middle of the depth of focus. 

 

Figure 3.1 White Painted Optical Flat 

 

Note: Avoid touching the top surface of the optical flat. 
Doing so could leave fingerprints or scratches on the 
surface and result in measurement errors. Carry the flat 
by its edges and store it safely when not in use. 

2. Jog the flat up or down to ensure that the ends of the vertical line from the 
projector crosshairs line up with the ends of the software crosshairs as closely as 
possible. This ensures the block is in the middle of the depth of field. See Figure 
3.2. 

 

Note: The projector vertical crosshair line may appear 
somewhat curved; this is a normal consequence of lens 
distortion and is accounted for in the system calibration.  
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Figure 3.2 Projector and Software Crosshair Alignment 

3. Press the Calibrate button on the bottom left of the Camera Window. The system 
will jog the optical flat down and then back up using the sample support stage. 
Measurements are taken along the way and a calibration profile including lens 
distortion is created. A dialog shows calibration progress (Figure 3.3). When the 
calibration is complete a second dialog will confirm if the user wants to accept the 
new calibration results. 
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Figure 3.3 Calibration Progress Window 

3.3 Accuracy Check 

Once calibration is complete, the user can check system accuracy by going to the 
Accuracy Check dialog under Tools. The standard TherMoiré calibration step block can 
be used to check accuracy of the calibrated DFP system. 

1. Place the cal block on the sample support such that it is centered in the camera 
field of view. 

2. Jog the sample up or down to ensure that the projected crosshairs line up with 
the software crosshairs as closely as possible. This ensures the block is in the 
middle of the depth of field. 

 

Note: The projected crosshairs will be distorted by the 
shape of the calibration block. As a result, it will not be 
possible to perfectly align the projector and software 
crosshairs. Line up the middle portion to ensure the 
block’s height is centered in the depth of field. 

3. Position the green bounding box such that the purple ROI’s inside cover the flat 
areas on the calibration block. Enter the calibration block step height from the 
calibration block certificate (Figure 2.17 or Figure 2.18) and press Measure. The 
step height result will be shown at the top of the dialog. The value measured 
should be within ±5µm of the value from the calibration certificate. 

4. Alternatively, set the Accuracy Check dialog to Optical Flat mode (Figure 3.5) 
and measure the optical flat. The standard deviation measured should be below 
10µm. 
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Figure 3.4 Accuracy Check Dialog 

 

Figure 3.5 Accuracy Check Optical Flat Dialog 
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3.4 Software Options 

DFP Surface Measurement options are the same as in Section 2.9, except for the 
Algorithm option. This option allows the user to change the phase shift calculation 
method from FixedShift to RandomShift. The difference between these algorithms is 
explained in the Akrometrix Optical Techniques and Analyses 101 manual. 

 

Figure 3.6 DFP Surface Measurement Options 

3.5 Software Operation 

DFP Surface Measurement and Thermal Profiler work very similarly to the standard 
versions. The user interacts with the same context menu commands in the Camera 
window as in Section 2.4, with the exception of the Show Crosshairs and Accuracy 
Check… commands. 
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4 DIC Surface Measurement 

The interface and operation of the DIC Surface Measurement program are very 
similar to the Surface Measurement program. A user unfamiliar with the Surface 
Measurement software should read Section 2 first or refer to it where necessary for 
operation of the DIC software. In this section, only DIC specific functions will be 
described. 

Because the DIC technique is fairly different than that of shadow moiré or fringe 
projection, the program interface is much simpler than for those techniques. No analysis 
or calibration functions exist in this software. The only major function available is to 
acquire images from both cameras simultaneously. 

 

Note: The system sample height adjustment stage is 
still in use. Instead of executing phase shifting, it is 
used to move the sample vertically for focusing 
purposes. 

4.1 Start-up 

1. Remove the TherMoiré grating from the oven lid if it is in place. 

2. Install the DIC module. (Refer to the DIC User Manual). 

3. Run the DIC Surface Measurement program by clicking the corresponding 
button on the Akrometrix Studio Manager toolbar on the left side of the screen. A 
start-up splash screen appears while the software initializes.  

4. When the Homing Sequence Confirmation Dialog is displayed (Figure 4.1), 
press Yes to continue program initialization. The TherMoiré sample support 
stage will home. 

 

Figure 4.1 Homing Sequence Confirmation 
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5. The main screen will display and it looks very similar to the normal Surface 
Measurement interface, except that it has two camera views instead of one 
(Figure 4.2). 

 

Figure 4.2 DIC Surface Measurement 

6. Right-click anywhere in the Camera window to Acquire data or change the 
camera zoom factor. 

4.2 Software Options 

A simplified options dialog (see Figure 4.3) is available in ToolsOptions, just as 
in normal Surface Measurement. There are no new options. The only difference with 
respect to normal Surface Measurement is that options that do not apply have been 
removed.

 

Figure 4.3 DIC Options Dialog 
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4.3 System Calibration 

Calibration of the stereo system requires capturing 15-20 images of a calibration 
target in different rotations for each image. This is accomplished by the following 
procedure: 

1. Setup the DIC system as described in the DIC User Manual. 

2. Position the calibration target underneath the cameras’ FOV. 

3. Capture an image of the calibration target, then rotate the target. Repeat 15-20 
times. The images will pop up, one on top of the other. 

4. Save the images into a project folder by using the FileSave All… command. 
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5 Troubleshooting 

5.1 Troubleshooting Data Acquisition 

As with any measurement system, Akrometrix TherMoiré products have their 
limitations. These limitations exist because the shadow moiré technique with phase 
stepping analysis is sensitive to the optical properties of the samples measured. The 
optical and analytical limitations of the system include: 

 Failure to obtain good fringe phase information. 

 Loss of resolution on samples with a wide range of reflectivity. 

5.1.1 Failure to Obtain Quality Phase Information 

Phase information is obtained for each pixel in an image by combining four images 
on a pixel-by-pixel basis. In general, quality phase information can be obtained 
anywhere good fringe contrast is observed in the raw video image. Frequently, good 
phase information can be calculated even where the human eye cannot resolve fringes; 
for example, against a permanent background pattern such as circuit traces. However, 
there are situations where quality fringes cannot be obtained: 

Symptoms: 

 An extremely noisy grayscale signal appears in the phase image. (Figure 5.1) 

 A banding pattern of grayscale values appears in the phase image.(Figure 5.2) 

 Discontinuities exist in the calculated displacement data. (Figure 5.3) 

 

Figure 5.1 Noisy Phase 
Image 

 

Figure 5.2 Banded Phase Image 

 

Figure 5.3 Discontinuity Errors in 
Displacement Data 

Cause: Discontinuous Sample 

Fringes are not generated at holes and cutouts or where the sample surface is 
shadowed by components or other obstructions; fringes can only appear on the sample 
surface itself. While these are obvious statements, the problems resulting from 
nonsense phase calculations within such localized regions frequently cause incorrect 
interpretation of the phase image. 

Surfaces with abrupt discontinuities, such as steps, components, or solder balls, 
can create analysis errors characterized by sharp diagonal edges in the calculated 
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displacement surface (Figure 5.3). For shadow moiré, abrupt implies adjacent pixels 
with a height difference greater than half the fringe value, e.g. greater than 0.005” 
(0.127 mm) for a 100 line per inch grating or 0.0017” (0.043 mm) for a 300 lpi grating. 

Solution: 

a. Use the Phase Amplitude option with an appropriate threshold value to 
automatically eliminate bad pixels from the phase image. 

b. Use a grating with a larger pitch, e.g. a 100 lpi grating instead of a 300 lpi. 

c. Apply a user-defined mask over holes and slots using Surface Analysis. See 
the Surface Analysis User Manual for more details. 

d. Within the Surface Analysis program, vary the filter conditions. 

Cause: Incorrect Phase Step Distance 

An incorrectly assigned phase step size results in the incorrect calculation of 
phases. This is due to incorrect software grating selection, incorrect calibration values, 
or physical contact between the sample and the grating. If the sample support frame is 
raised so that the sample is touching the grating, the sample is not uniformly translated 
relative to the grating during the phase stepping data acquisition. 

The grating is touching the sample (more generally, some point on the lid is 
touching some point on the sample support fixture), so that the grating does not 
translate independently of the sample during phase stepping. The phase image 
frequently has the appearance of Figure 5.2. Use the Sample/Grating Height 
adjustment dialog to manually raise and lower the sample at Slow Speed. If the sample 
is touching, the fringe pattern is frozen at some or all points on the sample. 

Solution: 

a. Lower the sample, or raise the grating, so that they are not touching. 

b. Check to make sure the correct grating is selected from the drop down list in 
the software. 

c. Open the calibration file and check that the grating value is within ±10% of the 
theoretical value. If not, perform calibration. 

Cause: Sample-Grating Distance 

A fringe pattern is not visible when the distance between the sample surface and 
the grating is too large. There is an effective working distance below the grating within 
which fringes on the sample surface can be observed. The shadow of the grating loses 
sharpness as the distance from the grating increases due to diffraction effects and finite 
thickness of the light source. As a rule of thumb, these distances are approximately: 

 0.8 in (20 mm) for the 50 lpi grating  

 0.2 in (5 mm) for the 100 lpi grating, and  

 0.02 in (0.5 mm) for the 300 lpi grating. 

Solution: 
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Adjust the height of the sample, either with the servomotor stages or by changing 
the sample support fixture. Position the sample so that it shows a high contrast fringe 
pattern on the raw video feed, but is not touching. If the sample is translated from this 
point using the servomotor stages, the user observes that the fringe pattern moves 
smoothly and uniformly across the sample. If some part of the fringe pattern does not 
move during translation, this usually indicates that that part of the sample is touching 
the grating. 

In some cases, it may not be possible to bring the sample surface within working 
distance of the grating, e.g. with a tall component or connector on the sample surface. 
Approaches Akrometrix has used under these circumstances include: 

 Inverting the sample and measuring the back surface, or 

 Using a lower resolution grating with a larger working distance. 

Cause: Unfavorable Surface Optical Properties 

The surface has unfavorable optical properties. Shadow moiré is based on diffuse 
reflection from the sample surface, which allows the interference patterns between the 
shadow grating and the reference grating to be observed. Surfaces that provide poor 
diffuse reflection include: 

 transparent surfaces, such as glass 

 specular reflecting surfaces, such as polished metal or solder pads 

 black or other dark-colored surfaces 

Solution: 

a. Using the Phase Amplitude option with an appropriate threshold value 
automatically masks regions with such unfavorable optical properties, 
excluding these bad pixels from the phase image and subsequently the 
analysis calculation. 

b. Painting the sample with a thin coat of high temperature white paint provides 
optimal surface properties for shadow moiré without significantly affecting 
mechanical properties. Other surface treatment methods may be used, 
depending on the sample, including creating a matte finish on a metal surface 
by etching or abrasion. 

c. Blurring the focus of the camera can help in some circumstances. For 
example, blurring allows a strong fringe signal from the terminal ring around a 
through-hole to combine with the weak fringe signal from adjacent regions of 
solder mask. This technique does reduce the lateral resolution of the 
measurement. 

Cause: Stray Sample Illumination 

Illumination of the sample by any light other than the linear fiber optic light source 
decreases the shadow contrast. In addition to ambient light, frequent sources of 
additional light are reflections inside the sample chamber and light from the infrared 
heating source. 
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Solution: 

a. Close system doors & turn off room lights. 

b. Shield off as much of the heater light as possible by laying black paper or 
cloth shields on top of the oven window. 

c. Make sure that the IR filter is in place on the camera lens. In extreme cases, 
shield off as much of the heater light as possible by laying black metal, paper 
or cloth shields on top of the oven window. 

5.1.2 Additional Sources of Error 

Several second-order effects have been observed in phase-stepped shadow moiré 
measurements that can affect results, particularly for extremely small and/or flat 
samples. Periodic structures in the apparatus or samples can introduce corresponding 
periodic errors in the phase image. In addition, the phase calculation algorithms inside 
Akrometrix software can introduce small periodic errors.  

High magnification of the sample can cause the grating lines themselves to be 
resolved, which can cause a periodic error in the phase calculation. Choose a 
combination of magnification and grating frequency so that the lateral resolution is at 
least one full grating pitch. The general guidelines below minimize this problem: 

1. If the full field of view of the video image is less than 160 mm in width, use a 100 
lpi or higher grating. 

2. If the full field of view of the video image is less than 60 mm in width, use a 300 
lpi or higher grating. 

Even when these guidelines are used, interference between camera pixel 
spacing and grating line spacing can produce aliasing in the video image. This initially 
appears as low contrast vertical (or near vertical) fringes across the image that vary in 
pitch and rotation as the zoom lens magnification is varied. This effect can be minimized 
by varying the lens magnification. 

Interference between a periodic structure on the sample surface (e.g. a field of 
solder pads on a BGA substrate) and the grating line spacing can introduce a periodic 
phase calculation error. This effect can generally be observed by eye in the live video 
image of the sample and may be eliminated by re-orienting the sample or changing the 
grating (e.g. from 100 lpi to 300 lpi). 

A second problem related not to system hardware, but to system software is 
caused by the breakdown of the sinusoidal approximation used in the phase calculation 
(see Akrometrix Techniques and Analysis 101). This appears as a series of ripples 
superimposed on the final displacement results. The ripples are characteristically 
parallel to the fringes appearing in the shadow moiré fringe pattern, but at four times the 
fringe frequency (a similar effect occurs when an incorrect step height is used, but the 
frequency of ripples is two times the fringe frequency). 

In general, the amplitude of the ripples is comparable to the resolution of the system 
and the effect on accuracy is within the system specification. However, saturation of the 
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video camera by regions of high reflectivity can enhance this effect to higher levels. If 
observed, this effect may be reduced through elimination of camera saturation by 
closing the lens iris or reducing light source power. In some cases, the effect may also 
be reduced by slightly increasing the distance between sample and grating. Consult 
with Akrometrix technical support if this effect is creating significant measurement 
problems. 

5.1.3 Loss of Contrast and Resolution 

A more subtle concern in making phase-stepped shadow moiré measurements 
deals with the relationship between the digital resolution of the intensity measurements 
and the precision of the vertical displacement data. The high resolution of the phase 
stepping method is based on the number of grayscale levels available when the fringe 
pattern is digitized. Using an 8-bit digitizer, there are 256 grayscale levels to encompass 
the fringe pattern from its brightest to darkest pixel. These 256 levels directly relate to 
the claim that vertical height measurement resolution is 100 times better than the 
grating pitch. If there are fewer levels available for digitization, the measurement 
resolution is proportionately reduced. 

 The manual lens iris should be adjusted so that maximum sample brightness is 
just below the saturation level of the digitizer. This is generally sufficient when the 
illumination and diffuse reflectivity of the surface is uniform across the sample. 
However, when the sample contains regions of high and low reflectivity, the fringe 
intensity signals from the two regions each cover only a small amplitude at the extreme 
high and low ends of the digitization range. In order to encompass both the dark fringe 
pixels in the low reflectivity region and the bright fringe pixels in the high reflectivity 
regions, each of the two signals spans a smaller range of digitization levels and the 
vertical displacement resolution in each region is reduced. 

 Painting the surface is the simplest procedure to eliminate this problem. If the 
surface cannot be painted, useful phase and displacement information can still be 
obtained for many samples, but the resulting loss of precision should be kept in mind. 
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Appendix A - Miscellaneous Information 

A.1 File Formats 

Akrometrix Surface Measurement saves data in a format with extension 
.akx_phase. These files should automatically be associated and can only be opened 
with the Surface Analysis application. Other image file formats can be exported from the 
program but cannot be loaded back into any Akrometrix software. Image export formats 
include: .bmp, .gif, .jpg, .png, and .tif. 

A.2 Keyboard Shortcuts 

F3 Toggle Fill ROI behavior 

F5 Bring Camera Window to foreground (will not hide Camera Window) 

F6 Show/Hide Sample Height Window 

F7 Show/Hide Camera Control Window 

F12 Perform an Acquire (capture data) 

Ctrl+T Open Thermal Profiler application 

Ctrl+S Save as *.akx_* 

Ctrl+I Save as image 

Ctrl+W Close 

Ctrl+O Open in Surface Analysis 

While the ROI has focus the following keyboard shortcuts apply: 

Ctrl+5 make ROI its maximum size. 

Alt+5 make ROI half of maximum size and position in center of field of view. 

Up Arrow or 8 on NumPad Move ROI up one pixel 

Down Arrow or 2 on NumPad Move ROI down one pixel 

Left Arrow or 4 on NumPad Move ROI left one pixel 

Right Arrow or 6 on NumPad Move ROI right one pixel 

1 on NumPad Move ROI down one pixel and left one pixel 

3 on NumPad Move ROI down one pixel and right one pixel 

7 on NumPad Move ROI up one pixel and left one pixel 

9 on NumPad Move ROI up one pixel and right one pixel 

Ctrl plus any of the above will increase the ROI size in the desired direction. 

Alt plus any of the above will decrease the ROI size in the desired direction. 
 


